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Introduction

The American rail of the 1800’s.

Though England can claim Richard Trevithick as the father of steam locomotion (1801) 
the actual origins of the railroad date back to 1556 and German physicist Georgius 
Agricola’s idea of running mining carts on a track of wooden poles.

Early on, Americans drew much from Agricola’s inspiration, employing horse-drawn 
wagons on primitive railroads. But in 1830 Peter Cooper introduced the Tom Thumb, a 
steam locomotive that was light enough to run on domestic lines, and a whole new era 
was born. By 1850 U. S. tracks stretched 9,000 miles. Within a decade the rails tripled 
and the first transcontinental railroad was begun. By the turn of the century, American 
enterprises had built five transcontinental railroads--the rail network spread in all 
directions and totaled over 193,000 miles.

Objective
In Empire Builder you can capture the entrepreneurial spirit of America and build your 
own railroad empire. You and up to five other tycoons are locked in a power struggle 
that spans the continent as players race to create railroad empires by connecting cities 
throughout the continent. Deliver a variety of commodities to cities demanding those 
goods---making huge profits if you play your cards right. Different demand cards makes
each game unique. Be a mogul-in-the-making during an era of unprecedented wealth.

Winning the Game
The first player to achieve the winning conditions wins the game. In a Quick Start game 
(the default settings) you must amass $250 million and connect 5 major cities first to 
win. In other games the winning conditions are set by the player creating the game. 
Within the game, you can view the set conditions by clicking on the Game Opts 
subheading under the File pull down menu.

Empire Builder is a tightrope act, you must balance the cost of building track against the
short and long term returns--all the while adapting to the changing Demand cards.

 Against the best, one false step is all it takes.............
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Creating the Game
After you have successfully logged on to the MPG-Net Lobby, click on the Games door.
At the next screen, click on the Board Games door, then click on the door labeled 
Empire Builder. This will put you in the Empire Builder pub, from which you can talk, 
create games and invite players as you would in other MPG-Net games.

To play Empire Builder you must first create a game. At the far right of the Gold Game 
Bar, you will see a new icon, a train. This is the Empire Builder game icon. Click on this 
icon and you will see three icons on a blue bar. From left to right is the Create Game 
icon (a bust being sculpted), the Run Game icon (a running shoe), and the Invite icon 
(a card on a plate). Click ‘Create Game’ and the Create Game screen appears. You 
can change the parameters of the game from this screen…but we suggest initially 
playing with the Quick Start settings to learn the game. When you have finished, click 
OK. 

This will automatically bring up the Invite screen, which is one of the functions of the 
Communications Screen. Play by yourself or invite up to five players. Select an online 
player and click Invite. The player(s) you have selected will receive your invitation and 
may reply. When you receive the ‘RSVP’ from the person you have selected, 
acknowledge and click the Run Game icon. This will bring up a menu of Empire Builder 
games. To start the game, select the game you wish to play and click Play Game. The 
other player(s) you have invited will receive instructions to proceed to the pub, select, 
and play the selected game.

If you create a game but can find no one to play at this time, or if you decide not to play 
at this time, the game will be automatically stored unless you delete or cancel it. If you 
create a game, or play halfway through a game before stopping, this menu will allow 
you to Load, Select, and Play the game in the future.

While the game is loading you will see the Empire Builder title screen. After this you will 
see the Game Screen.

The Game Screen
On your Game Screen you will find the:

Menu Bar 
Game Map
Game Controls Panel
Player information and
Demand Cards 
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Tool Tips
When you point to a specific button or feature of the Empire Builder screen a message 
appears telling you what it is. You may toggle these messages off and on by clicking 
the Tool Tips option on the Help menu.

Menu Bar
The Menu Bar is at the top of the screen and functions as any menu bar. Click on the 
Menu bar heading to access the pull down menus. Most of the functions you will use 
are more easily accessed from the Game Control menu. The menu heading Regional, 
toggles the map between Regional and Global views. The Exit command is located 
under the File menu heading.

Game Map
Empire Builder is played on a map of the continental US and a small portion of Canada.
Red hexes represent major cities, red squares represent mid-size cities and orange 
circles represent small cities, black dots represent mileposts, and black triangles 
represent mountains. Mileposts are cheaper to build track through than building across 
mountains or rivers. 

*Note*  The Legend heading under the About menu displays this information.

The Regional map allows you to easily see the area in which you are building. Use the 
arrows on the scroll bar to move around this map. The Global map allows you to look 
at the entire playing board. You will want to use the Global map to plan your strategy 
for making runs. You can toggle between these two maps either by clicking on the 
Regional or Global heading in the menu bar, or, by clicking on the Map icon to the right 
in the Game Controls window.

Notes: 
· To display both the global and regional maps, click the Toggle Map button, and then position the 

windows by dragging so that they are not directly on top of each other. All components of the 
Game Screen can be dragged and moved in the same manner.

· In the Regional Map, right clicking on a city will bring up information about that city.
· In the Global Map, right click on a location to orient the Regional Map to that location when you 

switch map windows.

Game Controls Panel
The Game Controls Panel has most of the functions that you will use throughout the 
game. Initially, this window is to the far right, under the Menu Bar heading Help. 

Player Status Display
At the very top of the Game Controls Panel is the Player Status Display. Which player’s 
turn it is, and, during your turn, what phase you are in is displayed in this window. 

*Note*  You can also determine the player turn by placing the mouse pointer on the Player Display 
window. A Tool Tip will display player turn information.

Movement / Building Remaining
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This area displays the cost of Surveyed track, the Movement remaining, and Building 
moves remaining. 

End Turn
Some Empire Builder options automatically end your turn, otherwise click on this button
to end your turn. 

Draw Demand Cards
You may on occasion wish to draw new cards if the cards you have cost too much to 
use, yield too little revenue to make them profitable, or are impossible to play given the 
current layout of your track. Selecting this option will end your turn.

Telegraph
Click on this icon to communicate with other players in the game. Click on the box of
the player(s) you wish to communicate with (and your own to see your message 
displayed), and type your message in the text window. Hit <Enter>to send the 
message. If you send a message to specific players instead of all players the word 
“whispers” appears. This window also displays messages from the Empire Builder 
Advisor. 

*Note*  You can toggle this last function off by clicking the Messages Option on the Windows menu. But! 
this also disables the Auto Pickup / Deliver message which notifies you when you reach a city where you 
can pickup or deliver items on your selected Demand Cards.

Survey
Click on this icon to survey track before you build it. Please see ‘Playing the Game’ for 
more on this subject.

Dump Load
Select this when you have a full train and wish to load some more profitable cargo. You 
don’t get paid for dumping a load.

Build Track
After you are satisfied with your surveyed track, click on this icon to build the track.

Pick up Load
Choose this to pick up cargo when you reach the appropriate city.

Upgrade Train
For $20 million you can upgrade your freight train to either heavier (carries more 
freight) or faster (more moves per turn). When you amass another $20 million and wish 
to upgrade to super freight--heavier and faster--click on this icon again.

Deliver Load
When you have reached your cargo destination, select this icon to deliver your cargo 
and receive your payment.
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Move
Turns begin in the movement phase. If you do some surveying before you move, click 
on this icon to bring the movement phase back.

Automove
This icon automatically moves your train along a straight route, but stops for directions 
when you reach cities, or options in the track.

Map toggle
Use this icon, a map of the United States, to move back and forth between Regional 
and Global maps.

Disasters
Choose this to display the areas affected by recent events. Periodically, natural and 
man-made disasters occur …which can undo the best laid plans of mice and moguls.

Display Loads
If you click on your Demand cards you will notice commodity icons and dollar signs 
appear on the maps. While it is helpful to have the icons and dollar signs on the map to 
remind you where to pick up and deliver, during moving and surveying these ‘flags’ can 
obstruct your view. Click again to turn off the ‘flags’. 

Other areas of the Game Screen.

Player Display Window
In the lower right hand corner is your Player Display Window. This window shows your 
player ‘face’, your name, the type of train you have, the amount of cash on hand, and 
on the bottom, the cargo you are carrying. You can change your game face by clicking 
on it. This will bring up a window with multiple ‘face’ options. Select a new face by 
clicking on it.

Player Display windows for the other players in the game are initially arranged on the 
left hand side of the screen. You can move them by dragging them by the top of the 
window. Click and hold down with the LMB on the player face or train to display his / 
her loads and Demand cards. When you let up, the Demand cards revert back to yours.
Point at the face with the mouse pointer for Turn information.

*NOTE*  In your Player Display Window a crossing gate will open and the light will turn green when it’s 
your turn.

Demand Cards
At the bottom of the screen, under the Game map, are the Demand cards. A player 
starts the game with three Demand cards. Each card show three possible ‘runs’ that a 
player can make. A ‘run’ consists of delivering the commodity pictured to the destination
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shown and receiving the amount shown. Clicking on any run will show the locations of 
that commodity on the map, as well as the destination city. 

Example: Buffalo needs copper and is willing to pay $29 million for its delivery. Clicking 
on this run will display a dollar sign at Buffalo and copper icons in those cities which 
provide that commodity. After looking at all three demand cards, players may then 
determine where to most economically build track to make the deliveries profitable.

* Note * Once you have completed one run on any Demand Card, that Demand Card is    
  replaced by a new one, with a new set of runs. Wait and see how this new Demand 
 Card affects your building and moving plans.

Playing the Game
In a Quick Start game, each player begins with $60 million dollars, a freight train (which 
you receive on the fourth turn) and the wits God gave ‘em at birth. In a customized 
game you begin with $40 million and receive your train on Turn 3.

Building Track
Until you receive your train, you can only survey and build track. You can spend up to 
$20 million per turn to build track. 

Decide where you will build your first track, based on your demand cards. This should 
connect a city that provides a commodity with the city that will pay for it. You MUST 
start your track from either a major city, or your own track. 

Now that you have a plan you’re ready to start surveying. Click on the Survey button. 
Place the mouse cursor on the edge of the city you wish to build track from, and, 
holding down the left mouse button, begin connecting the mileposts in a line that will 
become your rail. You can stop and begin again. You may also Survey track by clicking 
from milepost to milepost.

* Hint * Try to build an efficient line. This will save you money in building your track and time in running 
your train.

As you survey for your rail, note how the cost increases in the Movement / Building 
remaining box. This indicates how much you will spend on your proposed rail should 
you decide to build it. Terrain effects the amount of money necessary to build a track. If 
you decide not to build along the surveyed line, retrace your steps and redraw, or click 
on the survey button again to clear the map and begin anew.

You can survey past your financial limits, but the track will only build as far as $20 
million each turn. When you are satisfied press the Build Track button. Don’t worry if the
track does not yet connect the two cities you need. You have more turns to do so. On 
your next turn continue laying your track.

Notes on Building Track:
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¨ ALWAYS try to build OUT from a major city, it’s cheaper. You can build out from a major city up to 
two times a turn.

¨ You must build track either from a major city, or your own already existing track.

¨ You can CROSS another players track but you cannot build ON their track.

¨ Move first, then build. Building will end your remaining movement.

¨ Make sure you build one step ahead, otherwise, you may find yourself stranded.

¨ You can either build OR upgrade your train in a turn…but not both. 

¨ When a track is flooded out all bridges must be rebuilt.

¨ Only TWO players can build track to a small city. Only THREE players can build track to a mid-size 
city.

¨ You do not have to build up to the $20 million dollar limit. Instead, you may wish to build less track 
and spend your money upgrading your train.

Borrowing Money
You might find that your resources run out before your limits do. You can borrow money
from the bank (the default is $5 million). Click on the Command menu heading and then
Borrow $. Remember, though, this money must be paid back at 100% interest. 
The Debt window will appear. You may turn it off or move it to another part of the 
screen. You can also display the debt window by clicking on the Window menu heading
and the Debt submenu heading.

Running your Freight Train
Depending on the game, on your 3rd or 4th turn your friendly conductor will notify you 
that your freight train is ready. Place the train by clicking on the city that will provide 
your load of commodities. 

Loading
Click on the Load button and choose the cargo you wish to load. The train you start 
with can only carry two loads at a time. It is always a good idea to carry a full cargo 
load, regardless of whether you have a destination for both cargoes. As the Demand 
cards turn, your second load might become valuable, or, you might find benefits in 
having a second load during Disasters.

Moving
The train you start the game with can only move 9 mileposts at a time. There are 
several ways to move the train. After clicking the Move button, you can click on any 
milepost in the direction you wish to move to instigate movement. Empire builder will 
automatically move you the allotted amount in that direction. This method of movement 
will also move you through cities. You may also move by clicking from milepost to 
milepost, by dragging the train along mileposts or by using the  Automove button. 
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Notes on Moving:

¨ If you don’t have a rail line to where you want to go, use someone else’s. This will cost you $4 million 
dollars per turn.

¨ Remember that there are no U-turns on a rail line. You can change directions only in cities.

¨ Be sure you know where you’re going to. There is no ‘undo’ or ‘backtrack’ .

Deliver load
When you have reached your destination click on the Deliver load icon. Select the 
cargo to deliver and click OK. You will automatically receive payment. You may deliver 
more than one cargo at a destination (both tobacco and cars to Los Angeles) but may 
only deliver the same type of cargo once (Los Angeles won’t take two loads of 
tobacco).

Upgrade
You can make your train either faster (12 mileposts per turn) or heavier (able to carry 
three loads instead of two) for $20 million dollars. To upgrade click on the Command 
menu heading. Select upgrade train. Click in the box beside your selection.

* Note *
¨ You can only upgrade once per turn. 

¨ You cannot upgrade and build in the same turn. 

¨ Upgrade your train after movement. Upgrading will end your turn.

¨ For another $20 million dollars you can upgrade to Superfreight, which is both faster and heavier (12 
moves and three loads). Click in the box beside this selection.
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